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I. Overview of Bolo
In the beginning, there was Bolo.  And then the people realized that BBC Micro 6502's were not God's 
gift to mankind.  Then came Macintosh, and, following in superiority, Stuart Cheshire.  Mr. Cheshire  
realized the great potential of Bolo, and, in the process, implemented one of the most intense real-time  
multi-user networking games ever designed for the Macintosh.  The popularity of Bolo at educational  
institutions  (and a  certain  unnamed computer  manufacturer  in  California  whose  logo is  deliciously 
edible) has proved its worth in a very short time.  The authors of BoloStar™ would like to caution 
anyone who intends to "work" not to play Bolo due to the serious nature of addiction.

II. Prelude to BoloStar™
Within a few months of fierce battle, Everard Island became a bit boring, with most players knowing 
every strength and weakness of the map.  As we became more and more frustrated with the limitations 
of Everard Island, we began dissecting the 'BMAP' resource, changing several of the confusing hex 
numbers to see what would happen.  Realizing a map editor was necessary, I began putting an interface 
together while Keith hacked apart the map format.  Within a week, Keith had the 'BMAP' resource 
completely figured, and we began to put together our first compilation of BoloStar™.  And then Mr. 
Cheshire released the BMAP format, indicating subtly that maps larger than the standard 52x104 could 
be built.  Quickly, BoloStar™ was fitted with new "multiple map size" capabilities.  Since that day, 
we've been adding tools left and right, trying to make sure that as many functionalities are present as 
possible.  At the time of this writing, K&D Software has worked well over 1300 man-hours on this 
project.

SHAREWARE AGREEMENT AND COPYRIGHT NOTICE
BOLOSTAR™  IS  DISTRIBUTED  STRICTLY  ON  A  SHAREWARE  BASIS.   YOU  ARE 
ENCOURAGED TO PASS IT ALONG, BUT YOU MUST KEEP THE APPLICATION TOGETHER 
WITH  THIS  DOCUMENTATION  AND  ALL  RELATED  DATA  FILES  WHEN  DOING  SO. 
MODIFICATION OF THIS APPLICATION IS DISCOURAGED AS WELL, AND IS CONSIDERED 
A VIOLATION OF THE SHAREWARE AGREEMENT.

K&D  SOFTWARE  TAKES  NO  RESPONSIBILITY  FOR  ANY  DAMAGE,  EXPLICIT  OR 
OTHERWISE, WHICH MAY OCCUR FROM USE OF BOLOSTAR™ OR ANY OF THE FILES IT 
CREATES.

Please support ShareWare: it is one of the best methods the computing community can use to keep 
the cost of software down.  By pirating you are hurting more than just the programmers.

By paying the ShareWare fee, you are entitled to the following:

• REMOVAL OF THAT *REALLY* ANNOYING REGISTRATION SPLASH SCREEN.
• IMMEDIATE RECEIPT OF ANY FUTURE BUG FIXES OR UPGRADES.



• YOUR NAME CAN BE ATTACHED TO ANY SAVED MAP.
• A VERY CLEAR CONSCIENCE.



System Requirements

BoloStar™ requires a Macintosh running System 7.0 or higher and at least 900K of memory available 
for  the  application  to  run  in.   It  is  32-bit  compatible  and runs  on  both  color  and black-and-white  
machines.  Please note that we now run on 68000 machines! Slowly, but surely...

Map Formats

BoloStar™ reads maps from Bolo 0.95d and higher, but only writes files compatible with Bolo 0.97 and  
higher.  This allows editing and conversion of old maps to the new format.  Since the designer of the 
game prefers using the new format, BoloStar™ does not support writing in the old file format.  Bolo  
0.97 has a virtual map size of 256 x 256.  However, the designer would like to limit the map sizes to 216 
x 216.  This means that there is a 20 cell border around the entire map in which Bolo will simply remove 
when the game is played.  BoloStar™ displays all 256 x 256 cells and will allow you to edit these cells, 
but only cells inside 20, 20 and 235,235 will actually be displayed by Bolo.  BoloStar™ has two features 
to help deal with this problem. First, you can use the Show Limits command to see where the border lies. 
Secondly, saving a map which contains objects in the border area will cause an alert to appear notifying 
you  and  asking  if  you'd  really  like  to  save  it  (which  will  truncate  your  map  in  Bolo,  but  not  in 
BoloStar™).

Getting Started

Launching BoloStar™ can be accomplished by either double-clicking the application or by dragging 
files containing maps (of any format) onto the application.  Once initialized, BoloStar™ will display a  
splash box asking you whether or not you would like to register your copy with K&D Software. By 
registering your copy, you will never again have to look at this splash box, nor will you have any trouble 
attaching your name to maps (See Map Info).  More importantly, registration gets you any future updates 
free of charge.  To register, just send a check for $10.00 to the address below.  Make checks out to Keith 
Fry:

K&D Software
2262 South Thrush Court SE

Grand Rapids, MI  49546



The Tool Bar

The Tool  Bar  rests  on  the  left  side  of  every  map window and consists  of  three  separate  sections:  
Drawing Tools, which work like the tools typical painting programs; Terrain Types, which act like the  
patterns in typical painting programs; and the Info Box, which displays critical information about the 
map.
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Drawing Tools:

Point Draws single points of the currently selected land type.  When the option 
key is held down while in the point tool, the eyedropper tool is active (See 
Eyedropper Tool below).

Eyedropper Activated  when  option-clicking  with  the  point  tool  selected,  the 
eyedropper  tool  will  automatically  select  the  land type  in  the  tool  bar 
corresponding to the land type on which you clicked.

Selection Allows selecting of a rectangular area of the screen for editing operations. 
Holding down the  shift  key constrains  the  rectangle  to  a  square.   The 
selection can be dragged by clicking inside the selection rectangle and 
dragging  the  selection.   Several  editing  commands  will  also  become 
available in the Edit menu. 

Line Draws a line in the selected land type.  When the shift key is held down 
while dragging, the line is constrained to angles of 45°.

Fill (Bucket) Fills an adjoining area of the same type with the selected type (for those of 
you new to this type of tool, it works just like pouring the selected land 



type into the map, with other land types acting as solid retaining walls).



Rectangle Draws a rectangle with the given land type.  The left rectangle tool draws 
a filled rectangle, and the right rectangle tool draws only the outline of the 
selected land type.  When the shift key is held down while dragging the 
rectangle, the rectangle is constrained to a square.

Oval Draws an oval with the given land type.  The left oval tool draws a filled 
oval, and the right oval tool draws only the outline of the selected land 
type.  When the shift key is held down while dragging the oval, the oval is 
constrained to a circle.

Maze Draws a  random maze  with  exactly  one  entrance  and one  exit.   After 
dragging a rectangle to be used for the maze, a dialog box will appear 
asking you to choose the maze exterior and interior land types.  Clicking 
OK  will  cause  generation  of  the  maze.   Note  that  large  mazes  can 
sometimes take over 20 seconds on a slow machine.

Zoom (Magnify) Zooms in and out of the map.  Clicking on a point in the map will make 
the map zoom in or out with the chosen point at the center of the screen.

Terrain Types:

The grass, swamp, tree, road, crater, rubble, shot wall, wall, mine and deep water terrain types  are used 
in conjunction with the tools mentioned above.  The pillbox and base types can only be used with the  
point tool.  Therefore, when any of the other tools are highlighted, the base and pillbox types are grayed 
and you will not able to see them again until the point tool is selected.

Mines cannot be placed on walls,  rubble, water, deep water, bases, or pillboxes.  Also, they will not  
show up in zoomed out black and white mode.

WARNING:  WE  STRONGLY DISCOURAGE PLACING MINES ON YOUR MAP. 
MINES  WILL BE  INVISIBLE  TO  ALL PLAYERS  AT  STARTUP AND  DO  NOT 
USUALLY ADD ANY EXCITEMENT TO THE MAP.  WHILE WE HAVE ADDED 
THIS  FUNCTIONALITY,  WE  BELIEVE  IT  TO  DETRACT  FROM  THE  TRUE 
ESSENCE OF THE GAME.

Bolo currently has a limit of 16 pillboxes and 16 bases on a map simultaneously  When you have placed 
this many on your map, BoloStar™ will not continue to add them to your map, and will force the  
disabling of the base tool, pillbox tool, or both depending on which has reached its limit.  Check the info 
box  (see  The  Info  Box)  to  see  how  many  bases  and  pillboxes  you  have  placed  on  your  map. 
Alternatively, the Map Info command (see Menus) can also provide base and pillbox information, as 
well as information about the number of starting locations on the map.

The Info Box

The info  box  is  located  under  the  land  types  in  the  tool  bar.   It  functions  to  show the  following  
information:

• The number of bases on the map
• The number of pillboxes on the map



• The current position of the cursor in map-cell coordinates (visible if mouse is in map)



The Menus

File Menu

The File menu allows you to create a new map, open an old map,  save the current map,  change the  
preferences, and change information about the map.

Open… Allows you to open Bolo map files of any kind.  Only files which could 
contain a map are shown.  Not all  files shown will necessarily contain 
maps.

Save Saves the map in the current window.  If the current window contains a 
newly created map (i.e., untitled) then you will be asked to name the map. 
Subsequent saves will not ask for the name of the map.  This command 
can also be used to convert an "old-format" map (i.e., maps with 'BMAP' 
resources in them, like from Bolo 0.95d, Bolo 0.95e, etc.) into the new 
format supported by Bolo 0.96.

Save As… Allows you to save the map in the current window to a map file other than 
the one it presently resides in.  This is useful when opening a map which 
you wish to use as a basis for a new map, but which you do not want to 
destroy by saving over.  This command can also be used to convert an 
"old-format" map (i.e., maps with 'BMAP' resources in them, like from 
Bolo 0.95d, Bolo 0.95e, etc.) into the new format supported by Bolo 0.96.

Save Scrap… Allows you to save the currently selected terrain as a Scrap.  IN ORDER 
FOR THIS SCRAP TO WORK PROPERLY, YOU SHOULD SAVE IT IN 
YOUR SCRAPS FOLDER!

Map Info... Allows you to view specific details about the current map.  You may also 
add or change the author name here.  When getting information on new 
maps, the default author name (set via the Preferences…, below) is used; 
if you are not the default author, you should change the author name.

Preferences... Allows you to change BoloStar™'s preference settings. Settings include:

Set what to do when BoloStar™ is launched. Make a new untitled 
window, display the open dialog box, or do nothing.

Set what to do when a new window is opened. Open maps in zoomed 
out mode, zoom windows to their maximum size, open maps from the 
center, and open maps in a particular level of zoom.
 
Set the default land type. This options is currently useless, and it may 
be removed altogether in a later revision. It has only minor implications at 
this time.

Set the default author name.  The author name is specific to BoloStar™ 
only and has no effect on other editors or Bolo.  By saving the author of 
the map, we allow credit where credit is due.   



The name of the map's creator,  if set, appears in the title of the window.

Set the default draw mode.  Choose either BlockMode, which is a very 
fast  drawing  method,  or  SmartMode,  which  is  a  slower  but  prettier 
drawing method.  On slower machines, we recommend always remaining 
in BlockMode unless printing.

Edit Menu

The Edit menu allows you to perform operations on the current selection. 

Undo Reverses  an  undesired  action.   Note  that  Undo  currently  uses  a  one-
operation  buffer;  this  means  that  hitting  Undo once  will  undo the  last 
operation, and hitting it again will undo the undo, leaving the original map 
in place.  Undo may not be available for some operations.

Cut Removes the selected terrain from the map and places it  in the editing 
buffer.  It will then be available for pasting or other editing operations. 
Note that Cut leaves deep water in place of the removed land in order to 
give the physical appearance of having removed land.

Copy Places the selected terrain in the editing buffer without removing it from 
the map.  It will then be available for pasting or other editing operations.

Paste Places the terrain in the editing buffer onto the map.  The pasted terrain 
will remain selected so that you can move it to any desired position.

Clear Removes the selected terrain from the map without placing it in the editing 
buffer.   Note that Clear leaves deep water in place of the removed land in 
order to give the physical appearance of having removed land.  Whatever 
was in the editing buffer before Clear was selected will still be there.

Select All Selects the entire map.

Flip Horiz. Makes a copy of the selected terrain and then mirrors the copy around a 
vertical axis. DOES NOT PRESERVE PILLBOX, BASE, AND START 
CHARACTERISTICS.

Flip Vertical Makes a copy of the selected terrain and then mirrors the copy around a 
horizontal axis. DOES NOT PRESERVE PILLBOX, BASE, AND START 
CHARACTERISTICS.

Remove all Starts Removes all starting positions from the map. This is a much quicker way 
to remove starting positions than doing so by hand.

Reset Pillboxes Resets the changeable parameters of all pillboxes to their default values.

Reset Bases Resets the changeable parameters of all bases to their default values.



Special Menu

The Special menu provides some of the more useful and interesting functionalities of BoloStar™.

Wind. Zoom Allows you to grow the window to maximum size.  Choosing Window 
Zoom again will return the window to its previous state.

Zoom In/Out Allows you to incrementally zoom in or out one level of zoom.

Map Zoom Hierarchical  menu  allowing  direct  access  to  any  of  the  four  levels  of 
zoom: 100%, 50%, 25%, or 12.5%.  Note that some levels of zoom will 
cause loss of detail, especially on black and white machines.  The actual 
usefullness of these zoom levels will depend on the hardware you have.

BlockMap Causes the current  window to use the BlockMode method of drawing. 
This method is extremely efficient and quick, yet doesn't look as good as 
SmartMap  will.   We  recommend  this  mode  for  almost  all  drawing 
operations.

SmartMap Causes the current  window to use the SmartMode method of drawing. 
This method is inefficient and slow, yet looks extremely nice in almost all 
levels of zoom.  We recommend this mode for final modes of display, such 
as printing or "showing off".

Show Ranges Allows you to see the firing range of any pillbox on the map.  This can be 
very useful  when determining where other  key objects  (such as  bases) 
should go in relation to pillboxes.  Detection range will be slightly smaller, 
and  may  be  shown in  later  versions  of  BoloStar™ if  demand  is  high 
enough.

Show Limits Displays a rectangle defining the 20-cell border.  Objects outside of this 
border will be truncated by Bolo!

Extensions Menu

Items in this menu come from the Extensions folder and are read in when the application is initialized. 
When you make a selection rectangle,  the Extensions menu will  become available.   Extensions are 
external code modules developed by Slot Machines, Ltd, K&D Software, and other developers. For  
information on how to develop your own code modules, see Developing Extensions.  You may upload 
and download other extensions from the BoloStar™ FTP site (see BoloStar™ FTP Site).

Note that if you put a new extension into the Extensions folder while still running BoloStar™, you won't  
see it in the Extensions menu until you restart the program.

Scraps Menu





Items in this menu come from the Scraps folder and are read in when the application is initialized.  
Whenever you make a selection, the Save Scrap… option becomes available under the File menu.  If 
you save a scrap, make sure you save it to the Scraps folder!  Doing so will cause it to be displayed 
in the Scraps menu immediately.  Simply selecting a scrap from this menu will put the scrap on the map  
for further editing. To place the scrap simply click off the selection rectangle!  You may download or 
upload scraps to the BoloStart™ FTP site (see BoloStar™ FTP Site).

Windows Menu

Allows you to quickly choose a window or stack them for easy viewing.  Stacking the windows stacks 
them back to front with the title bars visible so that they are easy to select.

Suggestions for Drawing Maps

Try to avoid past restrictions. Bolo allows map sizes up to 256x256 (216x216 usable), and it 
does not require the map to be rectangular! The author of Bolo has registered some disgust for 
the number of rectangular 52x104 maps coming out recently. We strongly urge you to make use 
of BoloStar™ to generate more realistic maps. Of course, K&D Software finds nothing wrong 
with the rectangular map, nor does it particularly dislike the 52x104 (even though it is totally  
unnecessary)...  we realize  that  these maps are  better  for  games which are  played by only a 
handfull of people.  But it should be noted that if you regularly play with more then seven or 
eight players, you should consider making larger maps.  Also, if you distribute your maps, you're 
taking the chance that they will not be liked by people who DO play in large games.

Avoid excessive mining.  While mines on a map are typically undesirable, many of our users find 
mines  an exciting evil.   We encourage the  use  of  all  tools  in  BoloStar™, including mines.  
However, we would like you to be aware that mines are invisible to everyone, and they serve to 
slow the game down.  Mining large strips of land so that one touch starts something like a 
Michigan Marching Band beat, then you are misusing the tool!

Go for functionality rather than artistry.  By far, the best maps in Bolo to date have been those 
which take into account the fact that Bolo is a functional game.  By placing terrain strategically 
instead of trying to make beautiful art, the map designed creates a game situation worthy of play.  
K&D Software encourages artistic design, but we'd like to caution you about it: When designing 
maps using BoloStar™, it is very easy to get caught up in the drawing aspect of the map... put 
yourself in check and ask if this map is strategically playable, i.e., does it have a purpose?

Developing Extensions

Registered users may request developer status from K&D Software by physical mail, electronic mail, or  
via the newsgroup alt.netgames.bolo.  Developing code modules for BoloStar™ is quite simple, but 
requires some programming knowledge of the Macintosh.  There is little stipulation on the language you 
use (although we will be furnishing you with a "C" header file -- you'll have to rearrange it for Pascal or  
other languages).  The code modules are done via callbacks, which allow us to provide you with a large 
number  of  codes  which  correspond  to  commands.   Basically,  you  call  a  function  and  give  it  the 
command code, pass it whatever arguments it needs, and then extract the results.  For more information, 
please feel free to write us or email us.  We're also quite active on the newsgroup mentioned earlier.



BoloStar™ FTP Site

BoloStar™  now  has  a  public  FTP  site  available  for  your  use  24  hours  a  day.   The  site  is 
mondo.engin.umich.edu, or if nameservice is unavailable, 141.212.68.14. The following directories are 
available:

Directory Contents Access
/pub/bolo/bolomaps Download maps here Rd
/pub/bolo/bolomaps/incoming/ Upload maps here Rd/Wr
/pub/bolo/bolostar/ Latest BoloStar™ builds Rd
/pub/bolo/bolostar/extensions/ Download extensions here Rd
/pub/bolo/bolostar/scraps/ Upload/download scraps here Rd/Wr
/pub/bolo/bolostar/tracker/ Latest BoloTracker builds Rd

We encourage you to upload whatever you think is interesting! We've gotten a lot of maps now, and 
we're quite pleased... we'd really like to see some more functional and non-rectangular maps. We'll be 
posting our new favorites often, so keep checking for new stuff! Also, BoloTracker is property of Slot 
Machines, Ltd., and all comments and such should be directed to fprefect@engin.umich.edu and NOT to 
K&D Software.

BoloStar™ Future Plans

K&D Software is still working hard to bring you the best in map editing abilities.  Among our future 
plans are the following:

o Real floating windows for easier pallete selection and more working map area
o Pen size control.. so you'll be able to draw more cells at one time and save yourself some ache
o DirectDraw, a new technique in screen drawing.. this should speed draws by up to 200%
o Player View will allow you to see what the map looks like from a player's viewpoint

There's much more, too. We really appreciate all the suggestions and feedback we've been getting from 
our users, and we hope we'll be able to implement everything you've asked for! Until then, keep on  
Boloin'!

Feedback

You may send any comments, questions, suggestions, or complaints to the authors (assuming they still 
have accounts at the University of Michigan)

Author BoloName Email Address
Dan Rudman Red Square rudman@engin.umich.edu
Keith Fry Luxembourg™ keithfry@engin.umich.edu

We are also available daily on the newsgroup alt.netgames.bolo


